[image: image1.png]




	

	V+ Interface for 

Microsoft Flight Simulator

	[image: image21.png]




	

	


	


Revision History

	Version
	Description
	Date

	1.0
	Initial Release
	May 28, 2002

	
	
	

	
	
	

	
	
	

	
	
	

	
	
	

	
	
	

	
	
	

	
	
	


Contents

4Introduction


4About SimPhonics


4Before reading this manual


4What is the V+ Interface for Microsoft Flight Simulator?


4About V+


4Configuration


4Editing V+ Designs


5Running V+ Designs


6Applications


6Custom Sound Models


6Drive Simulator Hardware


6Drive Custom Graphics


6Custom Radio Communications


8How does it work?


8Requirements


9Installation


9Installing V+


9Installing the Microsoft Flight Simulator I/O Device for V+


10Using the V+ interface with Microsoft Flight Simulator


10Verifying V+ Interface Loaded Properly


11Running the Program in Window Mode


11Enabling the Simulator


12Configuring V+


13Building V+ Designs


13Monitoring Game Variables


16A Sample V+ Aerodynamic Sound Model


17Editing the Panel Configuration File


17[Window Titles] section: Adding the V+ interface DLL to a panel


19[WindowXX] section: Describing Panel Windows


23Ports


23Format Column


24Bit Values


25Port Descriptions


42Appendix


42List of Figures


42List of Tables


43References


43Trademark Acknowledgments




[image: image19.png]


Introduction

[image: image2.png]



About SimPhonics

[image: image20.png]|- N i

Flght Help

0
O]

o o MW

e 02 0 ST C

BonLes G o

BEGLC B Furs ||

T |-
FiEL sam L

[=[Ofx]

Lonn e 6 onn aii e




SimPhonics manufactures hardware and software components for use in the simulation and training industry.  For more than fourteen years, they have produced digital audio systems for high performance military and commercial flight simulators. In the not too distant past, each company designed their own in-house audio system that were generally application specific.  SimPhonics saw a need for an off-the-shelf solution, and recognized that emerging Digital Signal Processing (DSP) technology could provide the answer.  This COTS (Commercial Off-the-Shelf) approach to technology was to be generally reusable and reconfigurable to limit application specific engineering Labor.  Consequently, SimPhonics Incorporated was the first company to produce a commercially available digital audio system for high performance flight simulators.  Today, their products are installed around the world in a variety of simulation and training environments and are no longer limited to audio.

Before reading this manual

Users of this device will need a basic understanding of configuring, editing and running V+ designs.  See the V+ User Manual or the V+ Development System Online Help for detailed instructions on creating and editing V+ designs.  Both are available for download at SimPhonics’ website: http://www.simphonics.com/support/downloads/docs/. 

The online help is also available by selecting Help > Contents from the V+ Visual Programming System menu.

What is the V+ Interface for Microsoft Flight Simulator?

This software component is an add-on for the V+ Visual Programming System that provides access to various dynamic variables within the Microsoft Flight Simulation 2002 environment, via the V+ environment.  These variables can then be connected to other devices that V+ supports such as actual aircraft instruments, graphically developed instruments, actual hardwired panels, etc.  By utilizing this V+ Interface the user can not only read and monitor, but also drive other devices with the MFS data.

About V+

V+ is a Visual Programming System based on a Visual Programming Language (VPL), which replaces conventional textual programming languages such as C++, FORTRAN, PASCAL, etc… in some applications.  Primarily, a VPL differs from a text-based language in that images replace the text, providing a more natural programming paradigm.

Configuration

V+ must be configured before it is used.  The Platform Configure dialog box, found in the V+ Run-Time System is used for configuration.

Editing V+ Designs

A design file in V+ is called a worksheet. Worksheets can be large complete designs or more compact designs that are part of a project.  The V+ system is divided into two separate executables, a development system and a run-time system that is also referred to as the Platform Shell.  The development system is used to create and edit designs, while the platform shell is used to configure the system and to execute the designs created in the editor. 

Please see the V+ User Manual or the V+ Development System Online Help for detailed instructions on creating and editing V+ designs. Both are available for download at SimPhonics’ website: http://www.simphonics.com/support/downloads/docs/. The online help is also available by selecting Help > Contents from the V+ Visual Programming System menu.

See A Sample V+ Aerodynamic Sound Model for an example of a V+ design.

Running V+ Designs

V+ programs can be executed from the Visual Editor or the Run-time System. Developers should run designs from the Visual Editor while building programs. This makes it easier to monitor data and adjust settings. However, once designs are complete, they should be run from the Run-time system.

Applications

Since V+ is commonly used in the military and commercial flight simulation industry for the rapid application development of simulation systems, this device provides many potential useful applications.  Any application benefiting from having desktop flight simulator data available for use could benefit.  Potential uses include:

· custom sound models

· drive simulator hardware

· drive custom graphics

· custom radio communications

Custom Sound Models

SimPhonics provides sound systems for commercial and military full flight simulators that are extremely realistic.  The same streaming engine found in V+ and SimPhonics SMx system can be used to produce realistic FAA level D capable sound models for Flight Simulator 2002.

Multiple speakers can be used.  If more than one sound card is installed, or a multi-channel sound card is used, sound can be directed to these speakers, providing a more realistic sound environment.

Enhanced sound models are possible.  The touchdown sound for example can now be a function of groundspeed, sideslip, touchdown speed and rate of descent.  Aerodynamic sounds can be a function of air impact pressure, surface position, etc.

Additional effects can be added.  For example, custom avionics warnings can be generated based on aircraft dynamics such as TCAS or GPWS.  Enhanced navigational tones and radio station indents can be added, that are a function of station signal strength.  

Drive Simulator Hardware

Actual aircraft instruments can be simulated, or connecting one of many I/O devices to V+ along with this device can drive simulated aircraft hardware instruments.  For example, a National Instruments card could be connected to drive actual analog and digital I/O.

Drive Custom Graphics

V+ can be used to connect to DISTi OpenGL Studio to create custom OpenGL panels and gauges that can be driven with this device to replace or enhance existing panels.

Custom Radio Communications

V+ also contains a DIS radio package for communications over networks.  This allows the simulator to be connected to DIS networks to communicate with other simulators using the DIS protocol.  The DIS protocol is used within the Department of Defense to interconnect full flight military simulators of various types, including ground vehicles.

Aircraft longitude, latitude, altitude, radio frequencies can all become part of the environment.  This allows correct curvature of the earth to affect the radio model.  Also, V+ features a built-in terrain database used for computation of signal to noise ratios for voice communications.

The screenshot below shows a SINCGARS radio that can be connected directly to the flight simulator COM1 radio controls.  The knobs and switches are manipulated with the mouse, and functions just like a real military radio.  The result is voice communications over DIS.  Other radio panels can be created using DISTi’s GLStudio product to create the panels, and SimPhonics V+ to connect it to flight simulator and DIS networks.
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Figure 1 - SINCGARS radio

How does it work?

The software interface for V+ uses the Microsoft panel gauge interface to gain access to data in the game.  This data is called token variables in the Microsoft panel SDK.  There is a DLL file (FSVPLusInt.gau) that is copied to the c:/program files/Microsoft games/FS2002/gauges directory that contains the V+ interface software.  

This interface appears to Microsoft Flight Simulator as a gauge although the only gauge on the panel is the V+ logo.  This is necessary in order to interface with the panel system.

The processor load on a Pentium 4 2.0 GHz machine can require up to .2ms of processor time if all variables are used. (This is a worse case scenario.)  This data can be viewed in real-time by monitoring the port “V+ INTERFACE PROCESSOR LOAD”.

Requirements

Your computer must be capable of running the following software in order to use the Microsoft Flight Simulator I/O Device for V+:

· Microsoft Flight Simulator 2002 Professional

· V+ Run Time System

Installation

You must first install V+ in order to use the device.

NOTE:  This installation will overwrite the Lear 45 panel configuration file.  If you have modified the Lear 45 panel, be sure to save it first. (Panel.cfg is located at c:\program files\Microsoft games\FS2002\aircraft\lear45\panel\panel.cfg)

Installing V+

There are 2 ways to install V+ on your computer:

· Install V+ from the CD

· Download V+ from Simphonics' V+ Download Page http://www.simphonics.com/support/downloads/software/.

To Install V+ from the CD:
1.   Insert the media and execute the setup program on the disk.

2.   The program's installer will walk you through the process off setting up the software. Follow the instructions and remove the CD when finished.

Note:  Be sure to use the recommended default settings.

Installing the Microsoft Flight Simulator I/O Device for V+

There are 2 ways to install this I/O device on your computer:

· Install the software from a CD.

· Download the software from Simphonics' V+ Download Page http://www.simphonics.com/support/downloads/software/.

To Install the Microsoft Flight Simulator I/O Device from the CD:
1.   Insert the media and execute the setup program on the disk.

2.   The program's installer will walk you through the process off setting up the software. Follow the instructions and remove the CD when finished.
Note: After the V+ interface is installed, the Lear 45 panel is the only panel that contains the V+ interface.  Other aircraft panels can be edited to include the interface.  See Editing the Panel Configuration File for more information.

Using the V+ interface with Microsoft Flight Simulator

The following configuration steps are necessary before using V+ with Microsoft Flight Simulator:

1. Verify the V+ interface DLL loaded properly

2. Run Flight Simulator in Window Mode

3. Enable the Simulator

4. Configure V+
Verifying V+ Interface Loaded Properly

Before you configure V+ make sure the V+ interface loaded properly. The screen below shows the Lear 45 panel.  If the V+ interface DLL has loaded properly, you will see the V+ logo as shown on the panel.  Editing the panel.cfg file can change the logo location.
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Figure 2 - Learjet 45 Panel with V+ Logo

To verify the V+ interface loaded properly:

1.   Start Microsoft Flight Simulator 2002.

2.   Select CREATE A FLIGHT.

3.   Select CHANGE under Current Aircraft.

4.   Select Learjet from the Aircraft manufacture drop box.

5.   Make sure the Aircraft Model is 45.

6.   Select OK
7.   Select FLY NOW! to display the Learjet 45 cockpit view.

8.   Verify the V+ logo is displayed on the panel as shown above. 

Note: leave this window open to continue with next section.

Running the Program in Window Mode

Running the flight simulator and monitoring data at the same time requires running flight simulator in window mode and reducing the size of the flight simulator window.  This allows manipulation of the flight simulator and V+ at the same time.
To run the program in window mode

1.   Open the Learjet 45 cockpit view. See the previous section, Verifying V+ Interface Loaded Properly for instructions on opening the Learjet cockpit view. 

2.   Press the ALT key to display the cockpit menu (see below).
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Figure 3 - Cockpit Menu

3.   Deselect Full Screen from the Views menu. This decreases the size of the program window so you can see other programs running on your computer.

Enabling the Simulator

Next, ensure that the simulator can run while other tasks are loaded. 

To enable the simulator:

1.   Do this by clicking options, Settings > General.

2.   Un-check the “Pause on task switch” as shown below.
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Figure 4 - Clearing the "Pause on task switch"

Configuring V+

The next step is to configure V+. If Microsoft flight Simulator and the V+ interface has been loaded properly, the icon on the left as shown will turn green. 

Note: Microsoft Flight Simulator must be running in order to configure V+.

To configure V+:

1.   Select Programs > VPLus > V+ Run-Time System from the Start menu to launch the V+ Run-Time System.

2.   Select Configure. This opens the Platform Configure dialog box.

3.   Select the I/O Devices tab from the Platform Configure dialog box.

4.   Double click the icon next to the FS Interface Device. 

Note:  If the V+ interface did not load properly, the following message is displayed. If you get this error message, make sure Microsoft Flight Simulator is running.

[image: image7.png]1\ ContLossirietoetofig St

(i





Figure 5 - V+ Flight Simulator Load Error

5.   Click OK to return the main window.

6.   Select File > Save As to save this configuration and avoid having to repeat these steps each time you start V+.

[image: image8.png]Configurable Network Socket

B Etheret UDP/P

B Josick Inpu Device
B Windows Audio Miser

Conligure

Help

[

Cancel





Figure 6 - V+ Platform Configure Window

Building V+ Designs

Once the V+ run-time system is configured, you can load the development system and build a design. Using the Visual Editor, a design is drawn on a worksheet by dragging objects from a list of available objects and dropping them in place. These objects are then connected via nets to other objects or ports. Ports are grouped into I/O Devices which are Input/Output objects connecting the design to real-world signals, such as RS-232, Ethernet, etc. Please see the V+ User Manual or the V+ Development System Online Help for detailed instructions on creating and editing V+ designs. Both are available for download at SimPhonics’ website: http://www.simphonics.com/support/downloads/docs/. The online help is also available by selecting Help > Contents from the V+ Visual Programming System menu.

Monitoring Game Variables

Game variables are monitored using V+ ports placed on a V+ worksheet. See the V+ User Manual or the V+ Development System Online Help for detailed instructions on using ports and nets. Both are available for download at SimPhonics’ website: http://www.simphonics.com/support/downloads/docs/. The online help is also available by selecting Help > Contents from the V+ Visual Programming System menu.

To monitor a game variable:

1.   Launch the V+ Development System using any of the following methods:
· Select the [image: image9.png]


 button from the V+ Run-Time System toolbar.

· Select the executable file vplus.exe from the Windows Explorer. 

· Select Programs > VPLus > V+ Editor from the Start menu.

2.   Select New > File from the File menu or open an existing design.  The development will appear as shown.
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Figure 7 - V+ Visual Programming System Window

3.   Select [image: image11.png]


 or select View > Toolbars > Ports to open the Ports dialog box. If V+ was configured properly, the port dialog box contains a complete list of port variables referenced in Table 4 – Ports List.
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Figure 8 - Ports Dialog Box

4.   Double-click the port and drag it to the desired location on the active worksheet and click on the worksheet. The port is now displayed on the worksheet. Repeat this step to place all desired ports.

5.   Once the ports are on the worksheet, place “101 No Connection” objects, [image: image13.png]


, on the worksheet as shown below and connect them via nets in order to complete the design.

See the V+ Object Online Reference Guide for detailed information on V+ objects http://www.simphonics.com/support/downloads/docs/.
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Figure 9 - V+ "No Connection" Objects

6.   Select the green start icon [image: image15.png]


 to start V+.

7.   Right click on the port output pin. Output pins are the blue lines extending to the right of the port.

8.   Select Monitor. A gray box appears showing the value of the data at that point (see below). Below is an example of a monitor placed on the output pin of the square root object with an input value of "16."

[image: image16.png]7 +4,000000

oP1e




Figure 10 - Monitoring Data

9.   Right click on the monitor box and select Close to close the monitor box.
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Figure 11 - Closing the Monitor Box

A Sample V+ Aerodynamic Sound Model

The Lear 45 model does not seem to have an aerodynamic sounds model.  So, a sample is provided to demonstrate the device.

There is a sample aerodynamic sound model design for V+ and associated wave files that are supplied with the installation.  These files are located under C:\Program Files\VPLus\Designs directory.  The wave-files are stored at C:\Program Files\VPLus\Designs\WAVEFILES.

This design provides a simple sound model for the air impact effect on the fuselage, flaps and gear.  A speed-brake model could also be added easily.

The added realism of this aerodynamic model makes the aircraft more realistic since you can hear the effects of the various surfaces and be aware of their position in flight.  Otherwise, there is no sound associated with these surfaces.
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Figure 12 - V+ Aerodynamic Sound Model

Editing the Panel Configuration File

In order to add the V+ interface to other aircraft, you must edit the aircraft’s panel configuration file.  Refer to the Lear 45 panel for reference.

The primary folder used by the Panel system is the Panel folder. The Panel folder contains the panel background image files (.bmp) and the panel configuration file (Panel.cfg). When Flight Simulator 2002 loads an aircraft, it also loads the appropriate panel configuration file.  This file contains a reference to the V+ interface DLL.

If you have more than one version of an aircraft and you want a different panel layout for the second version, you will have more than one Panel folder. The name of the default Panel folder is Panel. Additional Panel folders must have the name Panel.xxx, where xxx is an identifying key. For example, the Cessna 182 ships with Panel.rg and Panel.ifr folders for the 182RG and IFR panels that come with Flight Simulator 2002 Professional Edition. The identification key is found in the Aircraft configuration file.

Every panel configuration file contains a section named [Window Titles] section
[Window Titles] section: Adding the V+ interface DLL to a panel

The Panel system creates the aircraft's panel windows by using the [Window Titles] section. The variables in this section are used to set the initial state of each panel window and each interior view.

· For each WindowXX variable in this section, the Panel system creates a panel window. It starts with Window00 and creates panel windows until it reaches Window63 or until it finds a break in the progression. The V+ interface DLL must be added to this section in order for the panel to load the DLL.

· The Panel system creates Fixed Window interior views with Fixed Window30 and continues up through Fixed Window37.

The order in which you assign panel windows or fixed windows doesn’t matter, so long as you start WindowXX at Window00 and Fixed WindowXX at Fixed Window30.

When creating the panel window, the system looks for corresponding [WindowXX] and [Fixed WindowXX] sections later in the configuration file. After the panel window is created, the gauges (and the V+ interface) listed in the [WindowXX] section are loaded.

For example, the Panel.cfg file for the Lear 45 contains the following information in this section:

[Window00]

file=Forward_640.bmp

file_1024=Forward_1024.bmp

size_mm=640

window_size_ratio=1.0

position=7

visible=1

ident=MAIN_PANEL

gauge00=Lear_45!AOA, 19, 122

gauge01=Lear_45!Chronometer, 0, 174

gauge02=Lear_45!Gear Lever, 586, 204

gauge03=Lear_45!Left Gear Light, 595, 184

gauge04=Lear_45!Right Gear Light, 616, 184

gauge05=Lear_45!Nose Gear Light, 605, 163

gauge06=Lear_45!Pitot Heat, 7, 237

gauge07=Lear_45!Deice, 38, 237

gauge08=Lear_45!Navigation Lights, 4, 264

gauge09=Lear_45!Strobe Lights, 34, 264

gauge10=Lear_45!Landing Lights, 8, 298

gauge11=Lear_45!Master Caution, 125, 30

gauge12=Lear_45!PFD,68, 76

gauge13=Lear_45!EICAS, 255, 76

gauge14=Lear_45!Radio Stack, 453, 143

gauge15=Lear_45!Pitch Trim, 535, 15

gauge16=Lear_45!Aileron Trim, 560, 26

gauge17=Lear_45!Rudder Trim, 608, 24

gauge18=Lear_45!Backup Airspeed, 442, 75

gauge19=Lear_45!Backup Attitude, 508, 75

gauge20=Lear_45!Backup Altimeter, 574, 75

gauge21=Lear_45!Left Starter, 515, 312

gauge22=Lear_45!Right Starter, 539, 312

gauge23=Lear_45!Battery, 445, 312

gauge24=Lear_45!Left Alternator, 467, 312

gauge25=Lear_45!Right Alternator, 489, 312

gauge26=Lear_45!Fuel Left Standby, 565, 312

gauge27=Lear_45!Fuel Right Standby, 617, 312

gauge28=Lear_45!Fuel Crossfeed, 591, 312

gauge29=Lear_45!Autopilot, 208, 16

gauge30=Lear_45!Nav GPS Switch, 178, 24

gauge31=FSVPLusInt!V+ Interface, 42, 105

gauge36=SimIcons!Kneeboard Icon, 597, 276

gauge37=SimIcons!ATC Icon, 611, 276

gauge38=SimIcons!Map Icon, 625, 276

gauge35=SimIcons!GPS Icon, 597, 290

gauge32=SimIcons!ECU Icon, 611, 290

gauge33=SimIcons!Compass Icon, 625, 290

The V+ interface DLL is shown in bolded blue text.

[WindowXX] section: Describing Panel Windows

This section describes a panel window (i.e., an individual panel): its shape, position, properties, the background image, and what gauges belong to the panel.

Table 1 - Panel Window Description

	Variable
	Description

	File
	Specifies the bitmap file to load and use for the low-resolution panel window background. (Flight Simulator 2002 uses a background designed for 640 by 480 resolution.) For example:

File=panel_background_640.bmp


This .bmp file must be in the same directory as the Panel.cfg file.

	file_1024
	Specifies the bitmap file to load and use for the high-resolution panel window background. For example:


FILE_1024=panel_background_1024.bmp


This .bmp file must be in the same directory as the Panel.cfg file.

	size_mm
	Specifies the size of the panel window, in millimeters. For example:


size_mm=640


To keep things simple during panel placement, you may want to consider using panels of 640 pixels in width and setting this value to 640 as well. The maximum design size for a panel is 8192 by 6144. You can also set the panel window’s aspect ratio using an X and Y value. For example:


size_mm=127, 185


	window_size_ratio
	Optional. Determines the width of panel window as a ratio of the client area of Flight Simulator main window. For example:

Window_size_ratio = 0.8

If not specified, 1.0 is the default.

	position
	Specifies the relative position of a panel window to the main window. For example:

position = 7
A number from 0 to 8 (as shown below) designates the position of the panel window. If nothing is specified, 7 is the default.

0 = upper-left corner
1 = upper-middle side
2 = upper-right corner
3 = middle-left side
4 = middle
5 = middle-right side
6 = lower-left corner
7 = lower-middle side
8 = lower-right corner


	window_pos
	Overrides the position and windowsize_ratio variables. Provide an x(,y) value.

window_pos=0.85, 0.3


	window_size
	Overrides the position and windowsize_ratio variables. Provide a w(,h) value.

window_size=0.5, 0.5


	background_color
	Use for a background created with no Bitmap color:

background_color=16, 16, 16


	visible
	Specifies the initial visible state of the panel window. For example:

visible=1
Valid entries are 1 or 0 as shown below. If nothing is specified, 1 is the default.

1 = panel window is visible
0 = panel window is hidden


	ident
	Specifies a unique identifier to define the panel window. For example:

ident=MAIN_PANEL
You must have an ident for each panel window. Valid entries are the following:

MAIN_PANEL
THROTTLE_PANEL
RADIO_STACK_PANEL
COMPASS_PANEL
MINI_CONTROLS_PANEL
ANNUNCIATOR_PANEL
ANNUNCIATOR2_PANEL
IFR_MAIN_PANEL
COLLECTIVE_PANEL
GPS_PANEL
OVERHEAD_PANEL

If your panel window’s description doesn’t fit any of above, use any number between 10000 and 19999.

	sizeable
	Specifies whether the panel window is sizeable with the mouse or not. For example:

sizeable=1
Valid entries are 1 or 0 as shown below. If nothing is specified, 1 is the default.

1 = panel window is sizeable
0 = panel window is fixed


	nomenu
	Specifies whether the menu will appear in the Flight Simulator Views menu. A value of 1 specifies that the window will not appear in the menu. By default, a panel window appears in the menu.

	render_3d_window
	Specifies the type of window on which to render. A value of 1 specifies that the gauge will render onto a 3-D view window, not a separate window. Note that you won’t be able to undock this panel. 

	type
	Specifies the type of the panel window. Valid entries are PANEL for aircraft panels, MINIPANEL for gauge windows shown in the “minipanel” mode, or SPECIAL for pseudo panel windows.

	pixel_size
	Specifies size of the panel window in pixels:

pixel_size=100,200

	gauge00–gaugeXX
	Specifies which gauge file to load and the X,Y position of the gauge. This is where the V+ interface DLL is found. The Panel system starts loading gauges, starting from gauge00 until it reaches gauge99. After that, it loads gauge100, gauge101, and so on until it finds a break in the progression. This comma-delimited variable exists primarily to specify which gauge DLL file to load and the X, Y position of the gauge, in millimeters. This will override the size_mm setting.

Here’s the basic format:

gauge##=gaugefile!gaugename, X, Y, W, H, parameters

Where:

gauge# – indicates the order in which the gauge is loaded.

gaugefile! – indicates the specific .gau file in which the gauge is found.

gaugename – displays the name of the gauge you assign in your gauge code via the GAUGE_NAME variable.

X, Y – indicates the X and Y position of the gauge, in millimeters, relative to the panel background.

W – indicates the width of the gauge in millimeters.

H – indicates the height of the gauge in millimeters.

Parameters – are passed to the gauge as a text string argument.

Here’s some examples:

gauge00=Cessna!ADF, 545, 86
gauge01=Cessna172!Airspeed, 145, 56
...
gauge21=Cessna182s!Autopilot_Switch, 68, 111, 30, 40
...
gauge39=SimIcons!Kneeboard Icon, 326, 280
...
gauge99=Cessna!Weather Radar, 201, 324, , , Color
gauge100=Cessna!GPS, 304, 568, , , Full



Ports

The following list of variables are available as ports in V+ once the I/O device is loaded. Some of the ports at the end of the list after “TRAILING_EDGE_FLAPS0_RIGHT_ANGLE” are special ports that are calculated based on other port values.  For example:  “VOR1_IDENTITY” is not useable in the list, and is replaced by the ports at the end, “VOR 1 ID STRING CHARACTER 1 OF 4”.  This is necessary since V+ is a floating-point data flow application, and strings do not flow through nets as floats.

Format Column

The FORMAT column found in the Port Descriptions table is interpreted as follows: 

Table 2 - Port Format Descriptions

	L = LOGICAL
	0 = FALSE
1 = TRUE

	BITS
	32 bit unsigned integer containing bit values converted to float 32.  For example:

Bit 0 and 2 set, represents a combination of 1 and 4 which is equal to 5. See bit value chart below.  

	F = FLOAT 32
	IEEE 32 BIT floating Point


Bit Values

Bit values are listed below.

Table 3 - Bit Values

	BIT
	VALUE

	0
	1

	1
	2

	2
	4

	3
	8

	4
	16

	5
	32

	6
	64

	7
	128

	8
	256

	9
	512

	10
	1024

	11
	2048

	12
	4096

	13
	8192

	14
	16384

	15
	32768

	16
	65536

	17
	131072

	18
	262144

	19
	524288

	20
	1048576

	21
	2097152

	22
	4194304

	23
	8388608

	24
	16777216

	25
	33554432

	26
	67108864

	27
	1.34E+08

	28
	2.68E+08

	29
	5.37E+08

	30
	1.07E+09

	31
	2.15E+09


Port Descriptions

Table 4 - Ports List
	V+ Port Name
	FORMAT
	Description

	TICK18
	F
	Incremented at 18hz. Used for general purpose timing.

	GROUND_ALTITUDE
	F
	Specifies ground level altitude (1/256 meter/unit).

	CLOCK_HOUR
	F
	Specifies local clock time, hours (0–23).

	CLOCK_MINUTE
	F
	Specifies local clock time, minutes (0–59).

	CLOCK_SECOND
	F
	Specifies local clock time, seconds (0–59).

	ZULU_HOUR
	F
	Specifies delta time from GMT.

	ZULU_MINUTE
	F
	Specifies delta time from GMT.

	ZULU_DAY
	F
	Specifies GMT day of year (1–365/366).

	ZULU_YEAR
	F
	Specifies GMT year.

	PANEL_LIGHTS
	L
	TRUE=panel lighting on. TRUE means number != 0.

	STROBE_LIGHTS
	L
	TRUE=strobe lights on.

	STROBE_FLASH
	L
	TRUE=strobe flash on model and screen.

	PITOT_HEAT
	L
	TRUE=pitot heat on.

	LANDING_LIGHTS
	L
	TRUE=landing lights on.

	SMOKE_ENABLE
	L
	TRUE=smoke system active.

	ADF_FREQUENCY
	F
	Specifies ADF frequency.

	ADF_500_HZ_TUNABLE
	F
	Specifies ADF frequency.

	ADF_EXTENDED_FREQUENCY
	F
	Specifies ADF frequency.

	ADF_IDENTITY
	F
	Pointer to string.

	ADF_SIGNAL_STRENGTH
	F
	0=no signal; >=256=good signal.

	ADF_MORSE_IDENT
	L
	TRUE=there is morse signal.

	ADF_CARD_RADIAL
	F
	Specifies integer degrees, 0–360.

	COM_FREQUENCY
	F
	Specifies BCD COM radio frequency.

	NAV1_FREQUENCY
	F
	Specifies BCD NAV1 radio frequency.

	NAV1_VOR_RADIAL
	F
	This returns degrees.

	NAV1_MORSE_IDENT
	L
	TRUE=there is morse signal.

	NAV2_FREQUENCY
	F
	Specifies BCD NAV2 radio frequency.

	NAV2_VOR_RADIAL
	L
	This returns degrees.

	NAV2_MORSE_IDENT
	L
	TRUE=there is morse signal.

	DME1_DISPLAY_TYPE
	L
	FALSE=distance readout; TRUE=speed, in knots, readout.

	DME1_DISTANCE
	F
	Specifies DME1 distance readout.

	DME1_SPEED
	F
	Specifies DME1 speed readout.

	DME1_MORSE_IDENT
	L
	TRUE=there is morse signa.

	DME2_DISPLAY_TYPE
	L
	FALSE=distance readout; TRUE=speed, in knots, readout.

	DME2_DISTANCE
	F
	Specifies DME2 distance readout.

	DME2_SPEED
	F
	Specifies DME2 speed readout.

	DME2_MORSE_IDENT
	L
	TRUE=there is morse signal.

	TRANSPONDER_CODE
	F
	Specifies octal transponder code (0000–7777).

	ADF_NEEDLE
	F
	16-bit pseudodegrees.

	VOR1_NEEDLE
	F
	+-127 correspond to +-10 if VOR or to +-2.5 if localiser.

	VOR1_GS_NEEDLE
	F
	+-120 correspond to +-0.7.

	VOR1_BACK_COURSE_FLAGS
	BITS
	BACKCOURSE STATUS of VOR1

BACKCOURSE AVAILABLE


0

LOCALIZER TUNNED

1

AIRCRAFT ON BACKCOURSE

2

STATION ACTIVE

7



	VOR1_TF_FLAG
	F
	VOR 1 TO/FROM FLAG STATUS

FLAG OFF

0

FLAG TO


1

FLAG FROM

2

	VOR1_GS_FLAG
	L
	TRUE=glideslope signal on VOR1.

	VOR1_OBI
	F
	VOR1 OBS setting in degrees.

	VOR1_CODE
	BITS
	VOR1 flags

LOCALIZER AVAILABLE
7

GLIDESLOPE AVAILABLE
6

BACKCOURSE UNAVAIL
5

DME TRANSMITTER AT GLIDE SLOPE TRANSMITTER
4

NO NAV SIGNAL AVAILABLE
3

VOICE AVAILABLE
2

VOR SIGNAL IS TACAN
1

DME AND VOR CO-LOCATED
0



	VOR1_IDENTITY
	F
	DO NOT USE

	VOR1_MAG_VAR
	F
	Magnetic deviation at location of VOR1 (65536 == 360 degrees).

	VOR1_SIGNAL_STRENGTH
	F
	0=no signal; >=256=good signal.

	VOR2_NEEDLE
	F
	+-127 correspond to +-10 if VOR or to +-2.5 if localiser.

	VOR2_BACK_COURSE_FLAGS
	F
	BACKCOURSE STATUS OF VOR 2

BACKCOURSE AVAILABLE


0

LOCALIZER TUNNED

1

AIRCRAFT ON BACKCOURSE

2

STATION ACTIVE

7



	VOR2_TF_FLAG
	F
	VOR 2 TO/FROM FLAG STATUS

FLAG OFF

0

FLAG TO


1

FLAG FROM

2

	VOR2_GS_FLAG
	L
	TRUE=glideslope signal on VOR2.

	VOR2_OBI
	F
	VOR2 OBS setting in degrees

	VOR2_CODE
	F
	VOR2 flags

LOCALIZER AVAILABLE
7

GLIDESLOPE AVAILABLE
6

BACKCOURSE UNAVAIL
5

DME TRANSMITTER AT GLIDE SLOPE TRANSMITTER
4

NO NAV SIGNAL AVAILABLE
3

VOICE AVAILABLE
2

VOR SIGNAL IS TACAN
1

DME AND VOR CO-LOCATED
0



	VOR2_IDENTITY
	F
	DO NOT USE

	VOR2_MAG_VAR
	F
	Magnetic deviation at location of VOR2 (65536 == 360 degrees).

	VOR2_SIGNAL_STRENGTH
	F
	0=no signal; >=256=good signal.

	VOR2_BEARING_DEGREES
	F
	Bearing on VOR2 radial in degrees.

	AIRCRAFT_ON_GROUND
	L
	TRUE=aircraft is on the ground.

	AIRSPEED
	F
	Airspeed – Indicated or True (in knots).

	AIRSPEED_TRUE_CALIBRATE
	F
	Specifies the degrees of rotation of the TAS calibration card.

	BARBER_POLE_ASPD
	F
	Specifies moveable redline airspeed (1/128th knot/unit).

	MACH
	F
	Specifies mach; 64K=3.2.

	VERTICAL_SPEED
	F
	Specifies upward velocity, vertical speed (1/256th, m/sec).

	MACH_MAX_OPERATE
	F
	Maximum allowable mach number.

	STALL_WARNING
	L
	TRUE=5 knots before stall.

	OVERSPEED_WARNING
	L
	TRUE=over speed warning.

	TURN_COORDINATOR_BALL_POS
	F
	Specifies turn-coordinator ball position (-127–127).

	DELTA_HEADING_RATE
	F
	Specifies heading change rate (pseudodegrees/sec).

	PLANE_LATITUDE
	F
	Specifies current latitude of aircraft. (to get degrees divide by 40007000.0 and multiply by 360).

	PLANE_LONGITUDE
	F
	Specifies current longitude of aircraft. (to get degrrees divide by 281474976710656.0 and multipy by 360).

	PLANE_ALTITUDE
	F
	Specifies current altitude of aircraft. (meters)

	ALT_FROM_BAROMETRIC_PRESSURE
	F
	Indicated altitude in meters of feet depending on selected units.

	KOHLSMAN_SETTING_MB
	F
	Specifies knob position in milli-bars.

	KOHLSMAN_SETTING_HG
	F
	Specifies knob position in inches of hg.

	PLANE_PITCH_DEGREES
	F
	Degrees.

	ATTITUDE_INDICATOR_PITCH_
DEGREES
	F
	Degrees.

	PLANE_BANK_DEGREES
	F
	Degrees.

	ATTITUDE_INDICATOR_
BANK_DEGREES
	F
	Degrees.

	PLANE_HEADING_
DEGREES_MAGNETIC
	F
	Degrees.

	MAGNETIC_VAR
	F
	Magnetic north vs. true north angular error. (in degrees)

	WHISKEY_COMPASS_DEGREES
	F
	Specifies true degrees.

	PLANE_HEADING_DEGREES_GYRO
	F
	Degrees.

	GYRO_DRIFT_ERROR
	F
	65536 for 360 degrees.

	PLANE_HEADING_DEGREES_TRUE
	F
	True degrees.

	AIRCRAFT_AUTOPILOT_AVAILABLE
	L
	FALSE or TRUE.

	AIRCRAFT_FLAPS_AVAILABLE
	L
	FALSE or TRUE.

	AIRCRAFT_STALL_HORN_AVAILABLE
	L
	FALSE or TRUE.

	AIRCRAFT_ENGINE_MIXTURE_
AVAILABLE
	L
	FALSE or TRUE.

	AIRCRAFT_CARB_HEAT_AVAILABLE
	L
	FALSE or TRUE.

	AIRCRAFT_SPOILER_AVAILABLE
	L
	FALSE or TRUE.

	AIRCRAFT_IS_TAIL_DRAGGER
	L
	FALSE or TRUE.

	AIRCRAFT_STROBES_AVAILABLE
	L
	FALSE or TRUE.

	AIRCRAFT_TOE_BRAKES_AVAILABLE
	L
	FALSE or TRUE.

	AIRCRAFT_NAV1_AVAILABLE
	L
	FALSE or TRUE.

	AIRCRAFT_NAV2_AVAILABLE
	L
	FALSE or TRUE.

	AUTOPILOT_ACTIVE
	L
	Toggles autopilot master.

	AUTOPILOT_WING_LEVELER
	L
	Toggles wing leveler.

	AUTOPILOT_NAV1_LOCK
	L
	Toggles Nav 1 lock.

	AUTOPILOT_HEADING_LOCK
	L
	Toggles heading lock.

	AUTOPILOT_HEADING_LOCK_DIR
	F
	Specifies heading lock direction.

	AUTOPILOT_ALTITUDE_LOCK
	L
	Toggles altitude lock.

	AUTOPILOT_ALTITUDE_LOCK_VAR
	F
	Specifies altitude lock altitude in appropriate units.

	AUTOPILOT_ATTITUDE_HOLD
	L
	Specifies attitude hold.

	AUTOPILOT_GLIDESLOPE_HOLD
	L
	Specifies glideslope.

	AUTOPILOT_APROACH_HOLD
	L
	Specifies approach hold.

	AUTOPILOT_BACKCOURSE_HOLD
	L
	Specifies backcourse hold.

	AUTOPILOT_YAW_DAMPER
	L
	Specifies yaw damper.

	AUTOPILOT_AIRSPEED_HOLD
	L
	Specifies airspeed hold.

	AUTOPILOT_AIRSPEED_HOLD_VAR
	F
	Specifies airspeed hold var.

	AUTOPILOT_MACH_HOLD
	L
	Specifies airspeed hold.

	AUTOPILOT_MACH_HOLD_VAR
	F
	Specifies airspeed hold var.

	AUTOPILOT_VERTICAL_HOLD
	L
	Specifies vertical hold.

	AUTOPILOT_VERTICAL_HOLD_VAR
	F
	Specifies vertical speed hold var, in appropriate units.

	AUTOPILOT_ALTITUDE_MANUALLY_
TUNABLE
	L
	FALSE or TRUE.

	AUTOPILOT_HEADING_MANUALLY_
TUNABLE
	L
	FALSE or TRUE.

	AUTOPILOT_AUTO_THROTTLE_ARM
	L
	Auto throttle arm.

	AUTOPILOT_TAKEOFF_POWER_
ACTIVE
	L
	Takeoff/Go-around mode active.

	ENGINE_RPM_HOLD
	F
	Specifies rpm hold variable.

	ENGINE_CONTROL_SELECT
	F
	Specifies which engine will be controlled.

	NUMBER_OF_ENGINES
	F
	1=single 2=twin.

	PROP_ADVANCE_SELECTION
	F
	0=fixed 1=optimal 2=manual.

	THROTTLE_LOWER_LIMIT
	F
	Set by Flight Simulator 2000 for thrust reversers.

	OIL_QUANTITY_TOTAL
	F
	0...7fff (8 qt.).

	SYSTEMS_AVAILABLE
	F
	Makes all systems available.

	INSTRUMENTS_AVAILABLE
	F
	Specifies instruments available.

	PP_ADF
	L
	TRUE=ADF failure.

	PP_AIR
	L
	TRUE=AIRSPEED gauge failure.

	PP_ALTIM
	L
	TRUE=ALTIMETER failure.

	PP_ATTITUDE
	L
	TRUE=ATTITUDE gauge failure.

	PP_COM
	L
	TRUE=COM gauge failure.

	PP_COMPASS
	L
	TRUE=COMPASS failure.

	PP_ELECT
	L
	TRUE=There is no electricity in panels circuit.

	PP_ENGINE
	L
	TRUE=ENGINE gauges failure.

	PP_FUEL_IND
	L
	TRUE=FUEL indicator failure.

	PP_HEADING
	L
	TRUE=HEADING indicator failure.

	PP_VERT_VEL
	L
	TRUE=VERTICAL velocity indicator failure.

	PP_XPNDR
	L
	TRUE=TRANSPONDER failure.

	PP_NAV
	L
	TRUE=NAV gauges failure.

	PP_PITOT
	L
	TRUE=PITOT system failure.

	PP_TURN_COORD
	L
	TRUE=TURN COORDINATOR failure.

	PP_VACUUM
	L
	TRUE=VACUUM system failure.

	FUEL_TANK_CENTER_LEVEL
	F
	8388608.0 for 100 percent.

	FUEL_TANK_CENTER_CAPACITY
	F
	Gallons.

	FUEL_TANK_LEFT_MAIN_LEVEL
	F
	8388608.0 for 100 percent.

	FUEL_TANK_LEFT_MAIN_CAPACITY
	F
	Gallons.

	FUEL_TANK_LEFT_AUX_LEVEL
	F
	8388608.0 for 100 percent.

	FUEL_TANK_LEFT_AUX_CAPACITY
	F
	Gallons.

	FUEL_TANK_LEFT_TIP_LEVEL
	F
	8388608.0 for 100 percent.

	FUEL_TANK_LEFT_TIP_CAPACITY
	F
	Gallons.

	FUEL_TANK_RIGHT_MAIN_LEVEL
	L
	TRUE=on.

	FUEL_TANK_RIGHT_MAIN_CAPACITY
	F
	Gallons.

	FUEL_TANK_RIGHT_AUX_LEVEL
	F
	8388608.0 for 100 percent.

	FUEL_TANK_RIGHT_AUX_CAPACITY
	F
	Gallons.

	FUEL_TANK_RIGHT_TIP_LEVEL
	F
	8388608.0 for 100 percent.

	FUEL_TANK_RIGHT_TIP_CAPACITY
	F
	Gallons.

	FUEL_QUANTITY_RIGHT
	F
	Specifies total gallons of fuel, right engine. (in pounds)

	FUEL_QUANTITY_LEFT
	F
	Specifies total gallons of fuel, left engine. (in pounds)

	FUEL_QUANTITY_CENTER
	F
	Specifies total gallons of fuel, center engine. (in pounds)

	FUEL_WEGHT_PER_GALLON
	F
	Specifies weight of fuel, in pounds I.F. (6 lbs/gal = 1536)

	FUEL_TANK_SELECTOR
	F
	See FUEL_TANK_SELECTOR_ enum values.

	CROSS_FEED_SELECTOR
	F
	Settings are OFF, LEFT_TO_RIGHT, or RIGHT_TO_LEFT.

	BRAKES_LEFT_POS
	F
	0=off; 32k=full brakes.

	BRAKES_RIGHT_POS
	F
	0=off; 32k=full brakes.

	BRAKE_IND
	F
	0 = no "BRAKE" indicator, > 0 = "BRAKE" indicator on screen.

	PARKING_BRAKE_POS
	F
	0=off; 32k=full parking brakes.

	SPOILERS_ARMED
	F
	Spoilers desired position {0=retracted..16k=fully extended}.

	SPOILERS_HANDLE_POS
	F
	Spoilers desired position {0=retracted..16k=fully extended}.

	SPOILERS_POS_LEFT
	F
	Spoilers current position {0=retracted..16k=fully extended}.

	SPOILERS_POS_RIGHT
	F
	Spoilers current position {0=retracted..16k=fully extended}.

	FLAPS_HANDLE_POS
	F
	16K = dn, 0 = up.

	FLAPS_POS_LEFT
	F
	0 – 16,384

	FLAPS_POS_RIGHT
	F
	0 – 16,384

	GEAR_HANDLE_POS
	F
	16K = dn, 0 = up.

	GEAR_POS_NOSE
	F
	Center gear, 0–16K.

	GEAR_POS_LEFT
	F
	Left gear, 0–16K.

	GEAR_POS_RIGHT
	F
	Right gear, 0–16K.

	DISPLAY_UNITS
	F
	ENGLISH = 0

METRIC = 1

	SIM_SPEED
	F
	Specifies time dilation factor for Flight Simulator 2000 equations.

	ZOOM_FACTOR
	F
	Specifies zoom value of current window in real units.

	REALISM_SENSE
	F
	0 = unreliable - 100 = totally reliable.

	REALISM_SYSTEMS
	F
	Makes all realism systems available.

	RELIABILITY_SENSE
	F
	0 = unreliable - 100 = totally reliable.

	AMBIENT_TEMP_DEGREES_C
	F
	15º Celsius = 59º degrees F (1/256 degrees Celsius = 1 unit).

	AMBIENT_PRES_MBAR
	F
	1013.2 mb = 29.92 in Hg (1/16 mb =1 unit).

	AMBIENT_WIND_VEL
	F
	Specifies current wind velocity (knots).

	AMBIENT_WIND_DIR
	F
	Specifies current wind direction.

	AMBIENT_WINDE
	F
	Specifies east wind component i.f m/sec units.

	AMBIENT_WINDN
	F
	Specifies north wind component i.f m/sec units.

	AMBIENT_WINDA
	F
	Specifies alt wind component i.f m/sec units.

	BAROMETRIC_PRESSURE
	F
	Specifies barometric pressure experienced.

	ANGLE_OF_ATTACK_INDICATOR
	F
	Measures airspeed, (signed fraction of max indication).

	TOTAL_AIR_TEMP
	F
	[1+ .2(M**2)] in normal air (degrees celsius * 256).

	G_FORCE
	F
	624 == 1g.

	CHARGING_AMPS
	F
	Charging system amps - 1 amp=65535.

	SUCTION_PRESSURE
	F
	In hg.

	MARKER_BEACON_STATE
	F
	Specifies beacon; 0=no beacon, 1=outer, 2=middle, 3=inner.

	CURRENT_DME
	F
	DMECUR_DME1 or DMECUR_DME2.

	PANEL_STATE_FLAGS
	F
	Panel State Bits

MAIN_PANEL_VISIBLE         
BIT1

MAIN_PANEL_COMPOSED        
BIT2

ADLOCK_SERVER


BIT3

PADLOCK_CLIENT


BIT4

HELICOPTER_HUD_VISIBLE     
BIT5

AIRCRAFT_HUD_VISIBLE       
BIT6

AIRCRAFT_HUD_ON


BIT7

RADIO_STACK_VISIBLE        
BIT8

HUD_METRIC_OUTPUT       

BIT9

MAIN_PANEL_ON


BIT10

CONTROLS_HUD_VISIBLE

BIT11

RADIO_STACK_AUTOPOPED

BIT12

MAIN_PANEL_UNDOCKED

BIT13

AIRCRAFT_HUD_EXIST

BIT14

HELICOPTER_HUD_EXIST

BIT15

PANELS_LOAD_VISIBLE

BIT16

HUD_LOAD_VISIBLE


BIT17

PANEL_VISIBLE


BIT18

HUD_PANEL_VISIBLE

BIT19

	GET_GUN_AMMO
	F
	Number.

	GET_CANNON_AMMO
	F
	Number.

	GET_ROCKET_AMMO
	F
	Number.

	GET_BOMB_AMMO
	F
	Number.

	ENGINE_PRIMER
	F
	 0.0 -> 1.0 == in -> out.

	COWL_FLAPS
	F
	 0.0 -> 1.0 == closed -> open.

	MASTER_ALTERNATOR
	L
	TRUE=on.

	MASTER_BATTERY
	L
	TRUE=on.

	CARB_HEAT
	F
	 0.0 -> 1.0 == off -> on.

	FLIGHT_TIME
	F
	in 1/10 of hours.

	FUEL_PUMP
	L
	TRUE=on.

	BEACON_LIGHTS
	L
	TRUE=on.

	TAXI_LIGHTS
	L
	TRUE=on.

	RADIO_STACK_VISIBLE
	L
	TRUE=yes.

	HORIZON_BAR_OFFSET
	F
	-10 deg to + 10 deg.

	CURRENT_DME_DISTANCE
	F
	DME1 or DME2 distance in nautical miles.

	CURRENT_DME_SPEED
	F
	DME1 or DME2 speed in knots.

	CURRENT_DME_MIN
	F
	DME1 or DME2 minutes until arriving.

	WARNING_FUEL
	L
	TRUE=on.

	WARNING_FUEL_L
	L
	TRUE=on.

	WARNING_FUEL_R
	L
	TRUE=on.

	WARNING_VACUUM
	L
	TRUE=on.

	WARNING_VACUUM_L
	L
	TRUE=on.

	WARNING_VACUUM_R
	L
	TRUE=on.

	WARNING_OIL_PSI
	L
	TRUE=on.

	WARNING_VOLTAGE
	L
	TRUE=on.

	FUEL_TANK_CENTER2_LEVEL
	F
	8388608.0 for 100 percent.

	FUEL_TANK_CENTER2_CAPACITY
	F
	Gallons.

	FUEL_QUANTITY_CENTER2
	F
	Total Gallons.

	TOTAL_FUEL_QUANTITY_GALLONS
	F
	Total Gallons.

	SELECTED_FUEL_QUANTITY_
GALLONS
	F
	Total Gallons.

	SELECTED_FUEL_QUANTITY_LITERS
	F
	Total Liters.

	SELECTED_FUEL_QUANTITY_
PERCENT
	F
	0.0... 1.0.

	RECIP_ENGINE1_ENGINE_RPM
	F
	Revolutions per minute.

	RECIP_ENGINE1_MANIFOLD_
PRESSURE
	F
	Pounds per sq feet.

	RECIP_ENGINE1_THROTTLE_LEVER_
POS
	F
	0.0... 1.0.

	RECIP_ENGINE1_MIXTURE_LEVER_
POS
	F
	0.0... 1.0.

	RECIP_ENGINE1_PROP_LEVER_POS
	F
	0.0... 1.0.

	RECIP_ENGINE1_COWL_FLAP_POS
	F
	0 = closed, 1 = open.

	RECIP_ENGINE1_CARB_HEAT_POS
	F
	0 = off, 1 = on.

	RECIP_ENGINE1_ALTERNATE_AIR_POS
	F
	0 = closed, 1 = off.

	RECIP_ENGINE1_COOLANT_
RESERVOIR_PCT
	F
	0.0... 1.0.

	RECIP_ENGINE1_LEFT_MAG
	L
	TRUE=on.

	RECIP_ENGINE1_RIGHT_MAG
	L
	TRUE=on.

	RECIP_ENGINE1_STARTER
	L
	TRUE=on.

	RECIP_ENGINE1_BRAKE_POWER
	F
	Power delivered to the shaft (ft-lb/sec).

	RECIP_ENGINE1_PROP_TORQUE
	F
	Torque required by prop (ft-lb).

	RECIP_ENGINE1_COMBUSTION
	L
	TRUE=Combustion.

	RECIP_ENGINE1_TURBOCHARGER_
FAILED
	L
	TRUE=on.

	RECIP_ENGINE1_EMERGENCY_BOOST_ACTIVE
	L
	TRUE=on (Like WEP in the P51).

	RECIP_ENGINE1_EMERGENCY_BOOST_ELAPSED_TIME
	F
	How long emergency has been active (seconds).

	RECIP_ENGINE1_WASTEGATE_POS
	F
	Position of wastegate controller 1=closed (full boost), 0=open (no boost).

	RECIP_ENGINE1_EGT_DEGR
	F
	EGT degrees Rankine.

	RECIP_ENGINE1_TIT_DEGR
	F
	Turbine Inlet Temperature degrees Rankine.

	RECIP_ENGINE1_CHT_DEGR
	F
	CHT degrees Rankine.

	RECIP_ENGINE1_OIL_TEMP_DEGR
	F
	Oil Temperature degrees Rankine.

	RECIP_ENGINE1_RADIATOR_DEGR
	F
	Radiator temperature degrees Rankine.

	RECIP_ENGINE1_OIL_PRESS_PSF
	F
	Oil Pressure lbs/sqft.

	RECIP_ENGINE1_OIL_LEAK_PCT
	F
	Percent Oil leaked.

	RECIP_ENGINE1_FUEL_AVAILABLE
	F
	Fuel available to engine?

	RECIP_ENGINE1_FUELFLOW_PPH
	F
	Fuel flow in lbs/hr.

	RECIP_ENGINE1_TANK_SELECTOR
	F
	Fuel tank selector.

	RECIP_ENGINE1_TANKS_USED
	F
	Fuel tanks used.

	RECIP_ENGINE1_NUMBER_OF_TANKS_USED
	F
	Number of fuel tanks used.

	RECIP_ENGINE1_FUEL_PRESSURE_PSF
	F
	Fuel pressure in lbs/sqft.

	RECIP_ENGINE1_COMBUSTION_
SOUND_PCT
	F
	Percent of Sound (0 – 1).

	RECIP_ENGINE1_INDUCED_VELOCITY
	F
	fps, velocity induced by prop.

	RECIP_ENGINE1_DAMAGE_PERCENT
	F
	0.0–1.0.

	RECIP_ENGINE2_ENGINE_RPM
	F
	Revolutions per minute.

	RECIP_ENGINE2_MANIFOLD_
PRESSURE
	F
	Pounds per sq feet.

	RECIP_ENGINE2_THROTTLE_LEVER_
POS
	F
	0.0... 1.0.

	RECIP_ENGINE2_MIXTURE_LEVER_
POS
	F
	0.0... 1.0.

	RECIP_ENGINE2_PROP_LEVER_POS
	F
	0.0... 1.0.

	RECIP_ENGINE2_COWL_FLAP_POS
	F
	0 = closed, 1 = open.

	RECIP_ENGINE2_CARB_HEAT_POS
	F
	0 = off, 1 = on.

	RECIP_ENGINE2_ALTERNATE_AIR_POS
	F
	0 = closed, 1 = off.

	RECIP_ENGINE2_COOLANT_
RESERVOIR_PCT
	F
	0.0... 1.0.

	RECIP_ENGINE2_LEFT_MAG
	L
	TRUE=on.

	RECIP_ENGINE2_RIGHT_MAG
	L
	TRUE=on.

	RECIP_ENGINE2_STARTER
	L
	TRUE=on.

	RECIP_ENGINE2_BRAKE_POWER
	F
	Power delivered to the shaft (ft-lb/sec).

	RECIP_ENGINE2_SHAFT_TORQUE
	F
	Torque required by prop (ft-lb).

	RECIP_ENGINE2_PROP_TORQUE
	L
	TRUE=Combustion.

	RECIP_ENGINE2_STARTER_TORQUE
	L
	TRUE=on.

	RECIP_ENGINE2_COMBUSTION
	L
	TRUE=on (Like WEP in the P51).

	RECIP_ENGINE2_TURBOCHARGER_
FAILED
	F
	How long emergency has been active (seconds).

	RECIP_ENGINE2_EMERGENCY_BOOST_ACTIVE
	F
	Position of wastegate controller 1=closed (full boost), 0=open (no boost).

	RECIP_ENGINE2_EMERGENCY_BOOST_ELAPSED_TIME
	F
	EGT degrees Rankine.

	RECIP_ENGINE2_WASTEGATE_POS
	F
	Turbine Inlet Temperature degrees Rankine.

	RECIP_ENGINE2_PROP_BETA
	F
	CHT degrees Rankine.

	RECIP_ENGINE2_THRUST
	F
	Oil Temperature degrees Rankine.

	RECIP_ENGINE2_EGT_DEGR
	F
	Radiator temperature degrees Rankine.

	RECIP_ENGINE2_TIT_DEGR
	F
	Oil Pressure lbs/sqft.

	RECIP_ENGINE2_CHT_DEGR
	F
	Percent Oil leaked.

	RECIP_ENGINE2_OIL_TEMP_DEGR
	F
	Oil Temperature degrees Rankine.

	RECIP_ENGINE2_RADIATOR_DEGR
	F
	Fuel flow in lbs/hr.

	RECIP_ENGINE2_OIL_PRESS_PSF
	F
	Fuel tank selector.

	RECIP_ENGINE2_OIL_LEAK_PCT
	F
	Fuel tanks used.

	RECIP_ENGINE2_FUEL_AVAILABLE
	F
	Number of fuel tanks used.

	RECIP_ENGINE2_FUELFLOW_PPH
	F
	Fuel pressure in lbs/sqft.

	RECIP_ENGINE2_TANK_SELECTOR
	F
	Percent of Sound (0 – 1).

	RECIP_ENGINE2_TANKS_USED
	F
	fps, velocity induced by prop.

	RECIP_ENGINE2_NUMBER_OF_TANKS_USED
	F
	0–100%.

	RECIP_ENGINE2_FUEL_PRESSURE_PSF
	F
	Fuel pressure in lbs/sqft.

	RECIP_ENGINE2_COMBUSTION_
SOUND_PCT
	F
	Percent of Sound (0 – 1).

	RECIP_ENGINE2_INDUCED_VELOCITY
	F
	fps, velocity induced by prop.

	RECIP_ENGINE2_DAMAGE_PERCENT
	F
	0.0–1.0.

	RECIP_ENGINE3_ENGINE_RPM
	F
	Revolutions per minute.

	RECIP_ENGINE3_MANIFOLD_
PRESSURE
	F
	Pounds per sq feet.

	RECIP_ENGINE3_THROTTLE_LEVER_
POS
	F
	0.0... 1.0.

	RECIP_ENGINE3_MIXTURE_LEVER_
POS
	F
	0.0... 1.0.

	RECIP_ENGINE3_PROP_LEVER_POS
	F
	0.0... 1.0.

	RECIP_ENGINE3_COWL_FLAP_POS
	F
	0 = closed, 1 = open.

	RECIP_ENGINE3_CARB_HEAT_POS
	F
	0 = off, 1 = on.

	RECIP_ENGINE3_ALTERNATE_AIR_POS
	F
	0 = closed, 1 = off.

	RECIP_ENGINE3_COOLANT_
RESERVOIR_PCT
	F
	0.0... 1.0.

	RECIP_ENGINE3_LEFT_MAG
	L
	TRUE=on.

	RECIP_ENGINE3_RIGHT_MAG
	L
	TRUE=on.

	RECIP_ENGINE3_STARTER
	L
	TRUE=on.

	RECIP_ENGINE3_BRAKE_POWER
	F
	Power delivered to the shaft (ft-lb/sec).

	RECIP_ENGINE3_SHAFT_TORQUE
	F
	Torque required by prop (ft-lb).

	RECIP_ENGINE3_PROP_TORQUE
	L
	TRUE=Combustion.

	RECIP_ENGINE3_STARTER_TORQUE
	L
	TRUE=on.

	RECIP_ENGINE3_COMBUSTION
	L
	TRUE=on (Like WEP in the P51).

	RECIP_ENGINE3_TURBOCHARGER_
FAILED
	F
	How long emergency has been active (seconds).

	RECIP_ENGINE3_EMERGENCY_BOOST_ACTIVE
	F
	Position of wastegate controller 1=closed (full boost), 0=open (no boost).

	RECIP_ENGINE3_EMERGENCY_BOOST_ELAPSED_TIME
	F
	EGT degrees Rankine.

	RECIP_ENGINE3_WASTEGATE_POS
	F
	Turbine Inlet Temperature degrees Rankine.

	RECIP_ENGINE3_PROP_BETA
	F
	CHT degrees Rankine.

	RECIP_ENGINE3_THRUST
	F
	Oil Temperature degrees Rankine.

	RECIP_ENGINE3_EGT_DEGR
	F
	Radiator temperature degrees Rankine.

	RECIP_ENGINE3_TIT_DEGR
	F
	Oil Pressure lbs/sqft.

	RECIP_ENGINE3_CHT_DEGR
	F
	Percent Oil leaked.

	RECIP_ENGINE3_OIL_TEMP_DEGR
	F
	Oil Temperature degrees Rankine.

	RECIP_ENGINE3_RADIATOR_DEGR
	F
	Fuel flow in lbs/hr.

	RECIP_ENGINE3_OIL_PRESS_PSF
	F
	Fuel tank selector.

	RECIP_ENGINE3_OIL_LEAK_PCT
	F
	Fuel tanks used.

	RECIP_ENGINE3_FUEL_AVAILABLE
	F
	Number of fuel tanks used.

	RECIP_ENGINE3_FUELFLOW_PPH
	F
	Fuel pressure in lbs/sqft.

	RECIP_ENGINE3_TANK_SELECTOR
	F
	Percent of Sound (0 – 1).

	RECIP_ENGINE3_TANKS_USED
	F
	fps, velocity induced by prop.

	RECIP_ENGINE3_NUMBER_OF_TANKS_USED
	F
	0–100%.

	RECIP_ENGINE3_FUEL_PRESSURE_PSF
	F
	Fuel pressure in lbs/sqft.

	RECIP_ENGINE3_COMBUSTION_
SOUND_PCT
	F
	Percent of Sound (0 – 1).

	RECIP_ENGINE3_INDUCED_VELOCITY
	F
	fps, velocity induced by prop.

	RECIP_ENGINE3_DAMAGE_PERCENT
	F
	0.0–1.0.

	RECIP_ENGINE4_ENGINE_RPM
	F
	Revolutions per minute.

	RECIP_ENGINE4_MANIFOLD_
PRESSURE
	F
	Pounds per sq feet.

	RECIP_ENGINE4_THROTTLE_LEVER_
POS
	F
	0.0... 1.0.

	RECIP_ENGINE4_MIXTURE_LEVER_
POS
	F
	0.0... 1.0.

	RECIP_ENGINE4_PROP_LEVER_POS
	F
	0.0... 1.0.

	RECIP_ENGINE4_COWL_FLAP_POS
	F
	0 = closed, 1 = open.

	RECIP_ENGINE4_CARB_HEAT_POS
	F
	0 = off, 1 = on.

	RECIP_ENGINE4_ALTERNATE_AIR_POS
	F
	0 = closed, 1 = off.

	RECIP_ENGINE4_COOLANT_
RESERVOIR_PCT
	F
	0.0... 1.0.

	RECIP_ENGINE4_LEFT_MAG
	L
	TRUE=on.

	RECIP_ENGINE4_RIGHT_MAG
	L
	TRUE=on.

	RECIP_ENGINE4_STARTER
	L
	TRUE=on.

	RECIP_ENGINE4_BRAKE_POWER
	F
	Power delivered to the shaft (ft-lb/sec).

	RECIP_ENGINE4_SHAFT_TORQUE
	F
	Torque required by prop (ft-lb).

	RECIP_ENGINE4_PROP_TORQUE
	L
	TRUE=Combustion.

	RECIP_ENGINE4_STARTER_TORQUE
	L
	TRUE=on.

	RECIP_ENGINE4_COMBUSTION
	L
	TRUE=on (Like WEP in the P51).

	RECIP_ENGINE4_TURBOCHARGER_
FAILED
	F
	How long emergency has been active (seconds).

	RECIP_ENGINE4_EMERGENCY_BOOST_ACTIVE
	F
	Position of wastegate controller 1=closed (full boost), 0=open (no boost).

	RECIP_ENGINE4_EMERGENCY_BOOST_ELAPSED_TIME
	F
	EGT degrees Rankine.

	RECIP_ENGINE4_WASTEGATE_POS
	F
	Turbine Inlet Temperature degrees Rankine.

	RECIP_ENGINE4_PROP_BETA
	F
	CHT degrees Rankine.

	RECIP_ENGINE4_THRUST
	F
	Oil Temperature degrees Rankine.

	RECIP_ENGINE4_EGT_DEGR
	F
	Radiator temperature degrees Rankine.

	RECIP_ENGINE4_TIT_DEGR
	F
	Oil Pressure lbs/sqft.

	RECIP_ENGINE4_CHT_DEGR
	F
	Percent Oil leaked.

	RECIP_ENGINE4_OIL_TEMP_DEGR
	F
	Oil Temperature degrees Rankine.

	RECIP_ENGINE4_RADIATOR_DEGR
	F
	Fuel flow in lbs/hr.

	RECIP_ENGINE4_OIL_PRESS_PSF
	F
	Fuel tank selector.

	RECIP_ENGINE4_OIL_LEAK_PCT
	F
	Fuel tanks used.

	RECIP_ENGINE4_FUEL_AVAILABLE
	F
	Number of fuel tanks used.

	RECIP_ENGINE4_FUELFLOW_PPH
	F
	Fuel pressure in lbs/sqft.

	RECIP_ENGINE4_TANK_SELECTOR
	F
	Percent of Sound (0 – 1).

	RECIP_ENGINE4_TANKS_USED
	F
	fps, velocity induced by prop.

	RECIP_ENGINE4_NUMBER_OF_TANKS_USED
	F
	0–100%.

	RECIP_ENGINE4_FUEL_PRESSURE_PSF
	F
	Fuel pressure in lbs/sqft.

	RECIP_ENGINE4_COMBUSTION_
SOUND_PCT
	F
	Percent of Sound (0 – 1).

	RECIP_ENGINE4_INDUCED_VELOCITY
	F
	fps, velocity induced by prop.

	RECIP_ENGINE4_DAMAGE_PERCENT
	F
	0.0–1.0.

	FUEL_QUANTITY_CENTER3
	F
	Total Gallons.

	SCORE_STRING_QUICK_COMBAT
	F
	Returns the Quick Combat score.

	SCORE_STRING_MULTIPLAYER
	F
	Returns the Multiplayer score.

	IS_MULTIPLAYER_TEAM_COMBAT
	F
	Turns the Multiplayer on.

	VOR1_BEARING_DEGREES
	F
	Measured in degrees.

	FORWARD_GROUND_VELOCITY
	F
	Measured in ft/sec.

	SIDE_GROUND_VELOCITY
	F
	Measured in ft/sec.

	VERTICAL_GROUND_VELOCITY
	F
	Measured in ft/sec.

	NORTH_VELOCITY
	F
	Measured in ft/sec.

	EAST_VELOCITY
	F
	Measured in ft/sec.

	VERTICAL_VELOCITY
	F
	Measured in ft/sec.

	CLOCK_TOTAL_SECONDS
	F
	Local clock time, seconds since midnight.

	GENERAL_ENGINE1_THROTTLE_
LEVER_POS
	F
	0.0... 0.1.

	GENERAL_ENGINE1_PROPELLER_
LEVER_POS
	F
	0.0... 0.1.

	GENERAL_ENGINE1_MIXTURE_
LEVER_POS 
	F
	0.0... 0.1.

	GENERAL_ENGINE1_OIL_TEMP
	F
	Oil Temperature degrees Rankine.

	GENERAL_ENGINE1_OIL_PRES
	F
	Oil Pressure lbs/sqft.

	GENERAL_ENGINE1_STARTER
	L
	TRUE=on.

	GENERAL_ENGINE1_FAILURE
	L
	TRUE=yes.

	GENERAL_ENGINE1_GENERATOR_
SWITCH
	L
	TRUE=on.

	GENERAL_ENGINE1_GENERATOR_
ACTIVE
	L
	TRUE=on.

	GENERAL_ENGINE1_EGT
	F
	EGT degrees Rankine.

	GENERAL_ENGINE2_THROTTLE_
LEVER_POS
	F
	0.0... 0.1.

	GENERAL_ENGINE2_PROPELLER_
LEVER_POS
	F
	0.0... 0.1.

	GENERAL_ENGINE2_MIXTURE_
LEVER_POS 
	F
	0.0... 0.1.

	GENERAL_ENGINE2_OIL_TEMP
	F
	Oil Temperature degrees Rankine.

	GENERAL_ENGINE2_OIL_PRES
	F
	Oil Pressure lbs/sqft.

	GENERAL_ENGINE2_STARTER 
	L
	TRUE=on.

	GENERAL_ENGINE2_FAILURE
	L
	TRUE=yes.

	GENERAL_ENGINE2_GENERATOR_
SWITCH
	L
	TRUE=on.

	GENERAL_ENGINE2_GENERATOR_
ACTIVE
	L
	TRUE=on.

	GENERAL_ENGINE2_EGT
	F
	EGT degrees Rankine.

	GENERAL_ENGINE3_THROTTLE_
LEVER_POS
	F
	0.0... 0.1.

	GENERAL_ENGINE3_PROPELLER_
LEVER_POS
	F
	0.0... 0.1.

	GENERAL_ENGINE3_MIXTURE_
LEVER_POS 
	F
	0.0... 0.1.

	GENERAL_ENGINE3_OIL_TEMP
	F
	Oil Temperature degrees Rankine.

	GENERAL_ENGINE3_OIL_PRES
	F
	Oil Pressure lbs/sqft.

	GENERAL_ENGINE3_STARTER 
	L
	TRUE=on.

	GENERAL_ENGINE3_FAILURE
	L
	TRUE=yes.

	GENERAL_ENGINE3_GENERATOR_
SWITCH
	L
	TRUE=on.

	GENERAL_ENGINE3_GENERATOR_
ACTIVE
	L
	TRUE=on.

	GENERAL_ENGINE3_EGT
	F
	EGT degrees Rankine.

	GENERAL_ENGINE4_THROTTLE_
LEVER_POS
	F
	0.0... 0.1.

	GENERAL_ENGINE4_PROPELLER_
LEVER_POS
	F
	0.0... 0.1.

	GENERAL_ENGINE4_MIXTURE_
LEVER_POS 
	F
	0.0... 0.1.

	GENERAL_ENGINE4_OIL_TEMP
	F
	Oil Temperature degrees Rankine.

	GENERAL_ENGINE4_OIL_PRES
	F
	Oil Pressure lbs/sqft.

	GENERAL_ENGINE4_STARTER 
	L
	TRUE=on.

	GENERAL_ENGINE4_FAILURE
	L
	TRUE=yes.

	GENERAL_ENGINE4_GENERATOR_
SWITCH
	L
	TRUE=on.

	GENERAL_ENGINE4_GENERATOR_
ACTIVE
	L
	TRUE=on.

	GENERAL_ENGINE4_EGT
	F
	EGT degrees Rankine.

	ELAPSED_SECONDS
	F
	Measured in seconds.

	G_FORCE_MAXIMUM
	F
	Maximum G Force (G's).

	G_FORCE_MINIMUM
	F
	Minimum G Force (G's).

	ENGINE_WORKING_TIME
	F
	Seconds.

	ENGINE1_MAX_RPM
	F
	Power RPM (0–16384 => 0–100% RPM).

	ENGINE2_MAX_RPM
	F
	Power RPM (0–16384 => 0–100% RPM).

	ENGINE3_MAX_RPM
	F
	Power RPM (0–16384 => 0–100% RPM).

	ENGINE4_MAX_RPM
	F
	Power RPM (0–16384 => 0–100% RPM).

	ATTITUDE_BARS_POSITION
	F
	Position ranges from -100 to 100.

	RAD_INS_SWITCH
	F
	Used in Concorde only.

	RADIO_HEIGHT
	F
	Meters.

	DECISION_HEIGHT
	F
	Meters.

	LOW_HEIGHT_WARNING
	F
	Boolean.

	COM_STBY_FREQUENCY
	F
	BCD; same as COM_FREQUENCY.

	COM_RADIO_25_KHZ_TUNABLE
	F
	BCD.

	NAV_LIGHTS
	F
	Nav lights.

	LOGO_LIGHTS
	F
	Logo lights.

	WING_LIGHTS
	F
	Wing lights.

	RECOGNITION_LIGHTS
	F
	Recognition lights.

	RADIO_MORSE_IDENT_STATES
	F
	0x1-VOR1, 0x2-VOR2, 0x4-DME1, 0x8-DME2, 0x10-ADF.

	GEAR_POS_AUX
	F
	0.0... 16384.0.

	TURB_ENGINE_1_N1
	F
	Percent.

	TURB_ENGINE_1_N2
	F
	Percent.

	TURB_ENGINE_1_CORRECTED_N1
	F
	Percent.

	TURB_ENGINE_1_CORRECTED_N2
	F
	Percent.

	TURB_ENGINE_1_CORRECTED_FF
	F
	Pounds per hour.

	TURB_ENGINE_1_PCT_MAX_TORQUE
	F
	0.0... 1.0.

	TURB_ENGINE_1_EPR
	F
	Ratio.

	TURB_ENGINE_1_ITT
	F
	Degrees Rankine.

	TURB_ENGINE_1_AFTERBURNER
	L
	TRUE=on.

	TURB_ENGINE_1_JET_THRUST
	F
	Pounds.

	TURB_ENGINE_1_BLEEDAIRPSI
	F
	PSI.

	TURB_ENGINE_1_TANK_SELECTOR
	F
	See FUEL_TANK_SELECTOR_.

	TURB_ENGINE_1_TANKS_USED
	F
	1 bit for each tank used.

	TURB_ENGINE_1_NUMBER_TANKS
	F
	Number of tanks used.

	TURB_ENGINE_1_FUELFLOW_PPH
	F
	Pounds per hour.

	TURB_ENGINE_1_FUEL_AVAILABLE
	F
	True yes.

	TURB_ENGINE_1_PCT_AREA
	F
	0.0... 1.0.

	TURB_ENGINE_1_PCT_REVERSER
	F
	0.0... 1.0.

	TURB_ENGINE_1_VIBRATION
	F
	Relative number.

	TURB_ENGINE_2_N1
	F
	Percent.

	TURB_ENGINE_2_N2
	F
	Percent.

	TURB_ENGINE_2_CORRECTED_N1
	F
	Percent.

	TURB_ENGINE_2_CORRECTED_N2
	F
	Percent.

	TURB_ENGINE_2_CORRECTED_FF
	F
	Pounds per hour.

	TURB_ENGINE_2_PCT_MAX_TORQUE
	F
	0.0... 1.0.

	TURB_ENGINE_2_EPR
	F
	Ratio.

	TURB_ENGINE_2_ITT
	F
	Degrees Rankine.

	TURB_ENGINE_2_AFTERBURNER
	L
	TRUE=on.

	TURB_ENGINE_2_JET_THRUST
	F
	Pounds.

	TURB_ENGINE_2_BLEEDAIRPSI
	F
	PSI.

	TURB_ENGINE_2_TANK_SELECTOR
	F
	See FUEL_TANK_SELECTOR_.

	TURB_ENGINE_2_TANKS_USED
	F
	1 bit for each tank used.

	TURB_ENGINE_2_NUMBER_TANKS
	F
	Number of tanks used.

	TURB_ENGINE_2_FUELFLOW_PPH
	F
	Pounds per hour.

	TURB_ENGINE_2_FUEL_AVAILABLE
	L
	True yes.

	TURB_ENGINE_2_PCT_AREA
	F
	0.0... 1.0.

	TURB_ENGINE_2_PCT_REVERSER
	F
	0.0... 1.0.

	TURB_ENGINE_2_VIBRATION
	F
	Relative number.

	TURB_ENGINE_3_N1
	F
	Percent.

	TURB_ENGINE_3_N2
	F
	Percent.

	TURB_ENGINE_3_CORRECTED_N1
	F
	Percent.

	TURB_ENGINE_3_CORRECTED_N2
	F
	Percent.

	TURB_ENGINE_3_CORRECTED_FF
	F
	Pounds per hour.

	TURB_ENGINE_3_PCT_MAX_TORQUE
	F
	0.0... 1.0.

	TURB_ENGINE_3_EPR
	F
	Ratio.

	TURB_ENGINE_3_ITT
	F
	Degrees Rankine.

	TURB_ENGINE_3_AFTERBURNER
	L
	TRUE=on.

	TURB_ENGINE_3_JET_THRUST
	F
	Pounds.

	TURB_ENGINE_3_BLEEDAIRPSI
	F
	PSI.

	TURB_ENGINE_3_TANK_SELECTOR
	F
	See FUEL_TANK_SELECTOR_.

	TURB_ENGINE_3_TANKS_USED
	F
	1 bit for each tank used.

	TURB_ENGINE_3_NUMBER_TANKS
	F
	Number of tanks used.

	TURB_ENGINE_3_FUELFLOW_PPH
	F
	Pounds per hour.

	TURB_ENGINE_3_FUEL_AVAILABLE
	L
	True yes.

	TURB_ENGINE_3_PCT_AREA
	F
	0.0... 1.0.

	TURB_ENGINE_3_PCT_REVERSER
	F
	0.0... 1.0.

	TURB_ENGINE_3_VIBRATION
	F
	Relative number.

	TURB_ENGINE_4_N1
	F
	Percent.

	TURB_ENGINE_4_N2
	F
	Percent.

	TURB_ENGINE_4_CORRECTED_N1
	F
	Percent.

	TURB_ENGINE_4_CORRECTED_N2
	F
	Percent

	TURB_ENGINE_4_CORRECTED_FF
	F
	Pounds per hour.

	TURB_ENGINE_4_PCT_MAX_TORQUE
	F
	0.0... 1.0.

	TURB_ENGINE_4_EPR
	F
	Ratio.

	TURB_ENGINE_4_ITT
	F
	Degrees Rankine.

	TURB_ENGINE_4_AFTERBURNER
	L
	TRUE=on.

	TURB_ENGINE_4_JET_THRUST
	F
	Pounds.

	TURB_ENGINE_4_BLEEDAIRPSI
	F
	PSI.

	TURB_ENGINE_4_TANK_SELECTOR
	F
	See FUEL_TANK_SELECTOR_.

	TURB_ENGINE_4_TANKS_USED
	F
	1 bit for each tank used.

	TURB_ENGINE_4_NUMBER_TANKS
	F
	Number of tanks used.

	TURB_ENGINE_4_FUELFLOW_PPH
	F
	Pounds per hour.

	TURB_ENGINE_4_FUEL_AVAILABLE
	L
	True yes.

	TURB_ENGINE_4_PCT_AREA
	F
	0.0... 1.0.

	TURB_ENGINE_4_PCT_REVERSER
	F
	0.0... 1.0.

	TURB_ENGINE_4_VIBRATION
	F
	Relative number.

	PROPELLER_1_RPM
	F
	Propeller 1 RPM.

	PROPELLER_1_PCT_MAX_RPM
	F
	0.0... 1.0.

	PROPELLER_1_THRUST
	F
	Pounds.

	PROPELLER_1_BETA
	F
	Radians.

	PROPELLER_1_FEATHERING_INHIBIT
	L
	TRUE=yes.

	PROPELLER_1_FEATHERED
	L
	TRUE=on.

	PROPELLER_1_SYNC_DELTA_LEVER
	L
	0.0... 1.0.

	PROPELLER_1_AUTOFEATHER_ARMED
	L
	TRUE=yes.

	PROPELLER_2_RPM
	F
	Propeller 2 RPM.

	PROPELLER_2_PCT_MAX_RPM
	F
	0.0... 1.0.

	PROPELLER_2_THRUST
	F
	Pounds.

	PROPELLER_2_BETA
	F
	Radians.

	PROPELLER_2_FEATHERING_INHIBIT
	L
	TRUE=yes.

	PROPELLER_2_FEATHERED
	L
	TRUE=on.

	PROPELLER_2_SYNC_DELTA_LEVER
	F
	0.0... 1.0.

	PROPELLER_2_AUTOFEATHER_ARMED
	F
	TRUE=yes.

	PROPELLER_3_RPM
	F
	Propeller 3 RPM.

	PROPELLER_3_PCT_MAX_RPM
	F
	0.0... 1.0.

	PROPELLER_3_THRUST
	F
	Pounds.

	PROPELLER_3_BETA
	F
	Radians.

	PROPELLER_3_FEATHERING_INHIBIT
	L
	TRUE=yes.

	PROPELLER_3_FEATHERED
	L
	TRUE=on.

	PROPELLER_3_SYNC_DELTA_LEVER
	F
	0.0... 1.0.

	PROPELLER_3_AUTOFEATHER_ARMED
	F
	TRUE=yes.

	PROPELLER_4_RPM
	F
	Propeller 4 RPM.

	PROPELLER_4_PCT_MAX_RPM
	F
	0.0... 1.0.

	PROPELLER_4_THRUST
	F
	Pounds.

	PROPELLER_4_BETA
	F
	Radians.

	PROPELLER_4_FEATHERING_INHIBIT
	L
	TRUE=yes.

	PROPELLER_4_FEATHERED
	L
	TRUE=on.

	PROPELLER_4_SYNC_DELTA_LEVER
	F
	0.0... 1.0.

	PROPELLER_4_AUTOFEATHER_ARMED
	L
	TRUE=yes.

	HYDRAULICS1_PRESSURE_PSF
	F
	Pound per sq foot.

	HYDRAULICS1_RESERVOIR_PCT
	F
	0.0... 1.0.

	HYDRAULICS2_PRESSURE_PSF
	F
	Pound per sq foot.

	HYDRAULICS2_RESERVOIR_PCT
	F
	0.0... 1.0.

	HYDRAULICS3_PRESSURE_PSF
	F
	Pound per sq foot.

	HYDRAULICS3_RESERVOIR_PCT
	F
	0.0... 1.0.

	HYDRAULICS4_PRESSURE_PSF
	F
	Pound per sq foot.

	HYDRAULICS4_RESERVOIR_PCT
	F
	0.0... 1.0.

	AVIONICS_MASTER_SWITCH
	L
	TRUE=yes.

	PANEL_AUTOFEATHER_SWITCH
	L
	TRUE=yes.

	PANEL_ANTIICE_SWITCH
	L
	TRUE=yes.

	PANEL_AUTOBRAKE_SWITCH
	F
	0=RTO, 1=Off, 2..4=1..3, 5=Max.

	DAY_OF_WEEK
	F
	0–6.

	DAY_OF_MONTH
	F
	1–31.

	CURRENT_MONTH
	F
	1–12.

	CURRENT_YEAR
	F
	1– 2002

	TIME_ZONE_OFFSET
	F
	Measured in minutes, positive west of GMT.

	DAYLIGHT_SAVING_ACTIVE
	L
	TRUE=yes.

	TOTAL_LOAD_AMPS
	F
	Amps.

	BATTERY_LOAD
	F
	Amps.

	BATTERY_VOLTAGE
	F
	Volts.

	MAIN_BUS_VOLTAGE
	F
	Volts.

	MAIN_BUS_AMPS
	F
	Amps.

	AVIONICS_BUS_VOLTAGE
	F
	Volts.

	AVIONICS_BUS_AMPS
	F
	Amps.

	HOT_BATTERY_BUS_VOLTAGE
	F
	Volts.

	HOT_BATTERY_BUS_AMPS
	F
	Amps.

	BATTERY_BUS_VOLTAGE
	F
	Volts.

	BATTERY_BUS_AMPS
	F
	Amps.

	GENERATOR_ALTERNATOR_1_BUS_
VOLTAGE
	F
	Volts.

	GENERATOR_ALTERNATOR_1_BUS_
AMPS
	F
	Amps.

	GENERATOR_ALTERNATOR_2_BUS_
VOLTAGE
	F
	Volts.

	GENERATOR_ALTERNATOR_2_BUS_
AMPS
	F
	Amps.

	GENERATOR_ALTERNATOR_3_BUS_
VOLTAGE
	F
	Volts.

	GENERATOR_ALTERNATOR_3_BUS_
AMPS
	F
	Amps.

	GENERATOR_ALTERNATOR_4_BUS_
VOLTAGE
	F
	Volts.

	GENERATOR_ALTERNATOR_4_BUS_
AMPS
	F
	Amps.

	GENERAL_PANEL_CIRCUIT_ON
	L
	TRUE=on.

	FLAP_MOTOR_CIRCUIT_ON
	L
	TRUE=on.

	GEAR_MOTOR_CIRCUIT_ON
	L
	TRUE=on.

	AUTOPILOT_CIRCUIT_ON
	L
	TRUE=on.

	AVIONICS_CIRCUIT_ON
	L
	TRUE=on.

	PITOT_HEAT_CIRCUIT_ON
	L
	TRUE=on.

	PROP_SYNC_CIRCUIT_ON
	L
	TRUE=on.

	AUTO_FEATHER_CIRCUIT_ON
	L
	TRUE=on.

	AUTO_BRAKES_CIRCUIT_ON
	L
	TRUE=on.

	STANDBY_VACUUM_CIRCUIT_ON
	L
	TRUE=on.

	MARKER_BEACON_CIRCUIT_ON
	L
	TRUE=on.

	GEAR_WARNING_CIRCUIT_ON
	L
	TRUE=on.

	HYDRAULIC_PUMP_CIRCUIT_ON
	L
	TRUE=on.

	ELEVATOR_DEFLECTION
	F
	Radians.

	ELEVATOR_TRIM
	F
	Radians.

	AILERON_DEFLECTION
	F
	Radians.

	AILERON_TRIM
	F
	Radians.

	RUDDER_DEFLECTION
	F
	Radians.

	RUDDER_TRIM
	F
	Radians.

	PROPSYNC_ACTIVE
	L
	TRUE=yes.

	INCIDENCE_ALPHA
	F
	Radians.

	INCIDENCE_BETA
	F
	Radians.

	TOTAL_FUEL_QUANTITY_LBS
	F
	Pounds.

	FLIGHT_DIRECTOR_ACTIVE
	L
	TRUE=yes.

	FLIGHT_DIRECTOR_PITCH
	F
	Degrees.

	FLIGHT_DIRECTOR_BANK
	F
	Degrees.

	CG_PERCENT
	F
	0.0... 1.0.

	CG_AFT_LIMIT
	F
	0.0... 1.0.

	CG_FWD_LIMIT
	F
	0.0... 1.0.

	CG_MAX_MACH
	F
	Mach.

	CG_MIN_MACH
	F
	Mach.

	STANDARD_ATM_TEMPERATURE
	F
	Standard atmosphere temperature at aircraft's altitude; Celsius.

	ENGINE_1_FUELFLOW_BUG_POSITION
	F
	Lbs per hour.

	ENGINE_2_FUELFLOW_BUG_POSITION
	F
	Lbs per hour.

	ENGINE_3_FUELFLOW_BUG_POSITION
	F
	Lbs per hour.

	ENGINE_4_FUELFLOW_BUG_POSITION
	F
	Lbs per hour.

	CONCORDE_VISOR_NOSE_HANDLE
	F
	0 – Visor Up, Nose Up, 1 – Visor Dn, Nose Up, 2 – Visor Dn, Nose 5 deg, 3 – Visor Dn, Nose 12.5 deg.

	CONCORDE_VISOR_POS_PCT
	F
	0=Up, 1.0 Extended/Down.

	CONCORDE_NOSE_ANGLE
	F
	Degrees; 0 – up.

	GEAR_POS_TAIL
	F
	0=Up, 16384=Down.

	ELEVON_1_DEFLECTION
	F
	The elevon indices start at 1 at the far left and increase to the right.

	ELEVON_2_DEFLECTION
	F
	Radians.

	ELEVON_3_DEFLECTION
	F
	Radians.

	ELEVON_4_DEFLECTION
	F
	Radians.

	ELEVON_5_DEFLECTION
	F
	Radians.

	ELEVON_6_DEFLECTION
	F
	Radians.

	ELEVON_7_DEFLECTION
	F
	Radians.

	ELEVON_8_DEFLECTION
	F
	Radians.

	PANEL_AUTOPILOT_SPEED_SETTING
	F
	Knots.

	AUTOPILOT_AIRSPEED_ACQUISITION
	L
	Boolean.

	AUTOPILOT_AIRSPEED_HOLD_
CURRENT
	L
	Boolean.

	AUTOPILOT_MAX_SPEED
	L
	Boolean.

	AUTOPILOT_CRUISE_SPEED
	L
	Boolean.

	BARBER_POLE_MACH
	F
	Real mach.

	SELECTED_FUEL_TRANSFER_MODE
	F
	 -1 off, 0 auto, 1 forward, 2 aft.

	HYDRAULIC_SYSTEM_INTEGRITY
	F
	 0.0 – complete failure; 1.0 – everything is OK.

	ATTITUDE_CAGE_BUTTON
	L
	TRUE=yes.

	VOR1_NEEDLE_RADIO
	F
	+-127 correspond to +-10 if VOR or to +-2.5 if localiser. Driven always by VOR.

	GPS_FLAGS
	BITS
	GPS FLAGS

GPS_FLAG_ACTIVE_FLIGHT_PLAN = 0x00002

GPS_FLAG_ACTIVE_WAY_POINT = 0x00004
LAST WAYPOINT REACHED = 0x00008
MANUAL FLIGHT PLAN ACTIVE = 0x00020

	GPS_POSITION_LAT
	F
	Degrees.

	GPS_POSITION_LON
	F
	Degrees.

	GPS_POSITION_ALT
	F
	Meters.

	GPS_MAGVAR
	F
	Magnetic deviation (radians).

	GPS_GROUND_SPEED
	F
	Meters per second.

	GPS_GROUND_HEADING
	F
	Radians (0 – 2PI); true heading, yaw.

	GPS_GROUND_TRACK
	F
	Radians (0 – 2PI); heading + magvar, magnetic yaw.

	GPS_WP_DISTANCE
	F
	Meters to next waypoint.

	GPS_WP_BEARING
	F
	Heading (radians) to next wp + magvar.

	GPS_WP_CROSS_TRK
	F
	Cross_trk (meters).

	GPS_WP_REQ_HDG
	F
	Required heading, magnetic, radians (0 – 2PI), from prev wp to next wp.

	GPS_WP_STRING
	F
	Name of next waypoint.

	GPS_WP_NEXT_LAT
	F
	Degrees.

	GPS_WP_NEXT_LON
	F
	Degrees.

	GPS_WP_NEXT_ALT
	F
	Meters.

	GPS_WP_PREV_LAT
	F
	Degrees.

	GPS_WP_PREV_LON
	F
	Degrees.

	GPS_WP_PREV_ALT
	F
	Meters.

	GPS_WP_TRUE_BEARING
	F
	True bearing, degrees.

	GPS_WP_TRUE_REQ_HDG
	F
	True required heading, degrees.

	GPS_DRIVES_NAV1
	F
	TRUE=COM1,ADF1 driven by GPS.

	HSI_VERTICAL_NEEDLE
	F
	-1.0 .. 1.0 corresponds to -10deg .. 10deg if VOR or to -2.5deg .. +2.5deg if localiser +5NM .. -5NM  if GPS.

	HSI_HORIZONTAL_NEEDLE
	F
	-1.0 .. 1.0 corresponds to -0.7deg .. +0.7deg.

	HSI_VERTICAL_VALID
	F
	0 – Nav flag on.

	HSI_HORIZONTAL_VALID
	F
	0 – GS flag on.

	HSI_TF_FLAG
	F
	-1.0 – from. 0.0 – none, 1.0 – to.

	HSI_OBI_NEEDLE
	F
	0 .. 360.

	HSI_DESIRED_HEADING_NEEDLE
	F
	0 .. 360.

	HSI_BEARING
	F
	0 .. 360.

	HSI_BEARING_VALID
	F
	1 – true.

	HSI_SIGNAL_LOCALISER
	F
	1 – true.

	HSI_SPEED
	F
	Knots.

	HSI_DISTANCE
	F
	NM.

	HSI_STATION_NAME
	F
	String.

	GEAR_POS_AUX
	F
	Aux gear 0 – 16k.

	TOOLTIP_UNITS 
	F
	TOOL TIP UNITS

DEFAULT = 0

METRIC = 1

US = 2



	LEFT_FOLDING_WING_PERCENT                      
	F
	0 – not folded; 1 – folded.

	RIGHT_FOLDING_WING_PERCENT
	F
	0 – not folded; 1 – folded.

	MAIN_EXIT_OPEN 
	F
	0 – not open; 1 – open.

	TAILHOOK_POSITION
	F
	0 – retracted; 1 – extended.

	COM2_FREQUENCY
	F
	BCD same as COM_FREQUENCY.

	COM2_STBY_FREQUENCY
	F
	BCD same as COM_FREQUENCY.

	NAV1_STBY_FREQUENCY
	F
	BCD same as COM_FREQUENCY.

	NAV2_STBY_FREQUENCY
	F
	BCD same as COM_FREQUENCY.

	COM1_TRANSMIT_SELECT
	L
	TRUE=yes.

	COM2_TRANSMIT_SELECT
	L
	TRUE=yes.

	COM_BOTH_RECEIVE
	L
	TRUE=audio receiving on both COMs.

	NAV1_SOUND_TOGGLE
	L
	TRUE=NAV1 sound on.

	NAV2_SOUND_TOGGLE
	L
	TRUE=NAV2 sound on.

	DME_SOUND_TOGGLE
	L
	TRUE=DME sound on.

	ADF_SOUND_TOGGLE
	L
	TRUE=ADF sound on.

	MARKER_SOUND_TOGGLE
	L
	TRUE=MARKER sound on.

	VOR2_GS_NEEDLE
	F
	GSI needle -119 to 119.

	GENERAL_ENGINE1_ANTI_ICE_POS
	F
	0 – off, 1 – on.

	GENERAL_ENGINE2_ANTI_ICE_POS
	F
	0 – off, 1 – on.

	GENERAL_ENGINE3_ANTI_ICE_POS
	F
	0 – off, 1 – on.

	GENERAL_ENGINE4_ANTI_ICE_POS
	F
	0 – off, 1 – on.

	ENGINE1_ON_FIRE
	F
	TRUE=yes.

	ENGINE2_ON_FIRE
	F
	TRUE=yes.

	ENGINE3_ON_FIRE
	F
	TRUE=yes.

	ENGINE4_ON_FIRE
	F
	TRUE=yes.

	ENGINE1_FUEL_PUMP_ON
	F
	TRUE=yes.

	ENGINE2_FUEL_PUMP_ON
	F
	TRUE=yes.

	ENGINE3_FUEL_PUMP_ON
	F
	TRUE=yes.

	ENGINE4_FUEL_PUMP_ON
	F
	TRUE=yes.

	GENERAL_ENGINE1_FUEL_VALVE
	F
	0 – closed, 1 – open.

	GENERAL_ENGINE2_FUEL_VALVE
	F
	0 – closed, 1 – open.

	GENERAL_ENGINE3_FUEL_VALVE
	F
	0 – closed, 1 – open.

	GENERAL_ENGINE4_FUEL_VALVE
	F
	0 – closed, 1 – open.

	GENERAL_ENGINE1_FUEL_PRESSURE
	F
	Pounds per sq feet.

	GENERAL_ENGINE2_FUEL_PRESSURE
	F
	Pounds per sq feet.

	GENERAL_ENGINE3_FUEL_PRESSURE
	F
	Pounds per sq feet.

	GENERAL_ENGINE4_FUEL_PRESSURE
	F
	Pounds per sq feet.

	WATER_RUDDER_ON
	F
	0 – off, 1 – on.

	PROP_DEICE_SWITCH
	L
	TRUE=on.

	STRUCTURAL_DEICE_SWITCH
	L
	TRUE=on.

	FUEL_TANK_SELECTOR_2
	F
	FUEL TANK SELECTOR BITS

SELECTOR OFF = 0

SELECTOR ALL = 1

SELECTOR LEFT = 2

SELECTOR RIGHT = 3

SELECTOR LEFT_AUX = 4

SELECTOR RIGHT_AUX = 5

SELECTOR CENTER = 6

SELECTOR CENTER2 = 7

SELECTOR CENTER3 = 8

SELECTOR EXTERNAL1 = 9

SELECTOR EXTERNAL2 = 10

SELECTOR RIGHT_TIP = 11

SELECTOR LEFT_TIP = 12

SELECTOR CROSSFEED = 13

SELECTOR CROSSFEED_L2R = 14

SELECTOR CROSSFEED_R2L = 15

SELECTOR BOTH = 16

SELECTOR EXTERNAL_ALL = 17



	TRAILING_EDGE_FLAPS0_LEFT_
ANGLE
	F
	Degrees.

	TRAILING_EDGE_FLAPS0_RIGHT_
ANGLE
	F
	Degrees.

	VOR 1 ID STRING CHARACTER 1 OF 4
	F
	ASCII CODE OF CHARACTER

	VOR 1 ID STRING CHARACTER 2 OF 4
	F
	ASCII CODE OF CHARACTER

	VOR 1 ID STRING CHARACTER 3 OF 4
	F
	ASCII CODE OF CHARACTER

	VOR 1 ID STRING CHARACTER 4 OF 4
	F
	ASCII CODE OF CHARACTER

	VOR 2 ID STRING CHARACTER 1 OF 4
	F
	ASCII CODE OF CHARACTER

	VOR 2 ID STRING CHARACTER 2 OF 4
	F
	ASCII CODE OF CHARACTER

	VOR 2 ID STRING CHARACTER 3 OF 4
	F
	ASCII CODE OF CHARACTER

	VOR 2 ID STRING CHARACTER 4 OF 4
	F
	ASCII CODE OF CHARACTER

	ADF ID STRING CHARACTER 1 OF 4
	F
	ASCII CODE OF CHARACTER

	ADF ID STRING CHARACTER 2 OF 4
	F
	ASCII CODE OF CHARACTER

	ADF ID STRING CHARACTER 3 OF 4
	F
	ASCII CODE OF CHARACTER

	ADF ID STRING CHARACTER 4 OF 4
	F
	ASCII CODE OF CHARACTER

	V+ INTERFACE PROCESSOR LOAD
	F
	Time in seconds required by the V+ interface software.  Normally this time is less than 1 ms.

	V+ INTERFACE FRAME RATE
	F
	The rate in Hertz that the V+ interface is called by the simulation.  This is not the same as the simulation rate.
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